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PREFACE

Microsoft Outlook is one of the widely used email clients used in organizations of all sizes, from 

large enterprises to small and mid-sized businesses. Aside from business messaging, the application 

also performs calendaring, task management, contacts management, and other crucial functions 

to facilitate workplace collaboration.

Outlook stores the user’s mailbox data such as emails, attachments, calendar schedules, 

contacts, tasks, notes, folders, etc., in an Outlook data file. This file, stored or cached on the user’s 

system, allows local access to email data without Internet connectivity, unlike the typical 

web-based email services such as Gmail. The Outlook data file can store several GBs of 

business-critical data, particularly for the tenured employees or users who exchange a significant 

number of emails. Therefore, a strong grasp of Outlook data file concepts is crucial for email 

administrators and Outlook users to manage their email database files, troubleshoot issues such 

as corruption, and protect the mailbox data from loss.

This Guide provides an in-depth understanding of Outlook data files, covering a wide range of 

aspects, like what are Outlook data files, their types, existence scenarios, etc. It also covers various 

Outlook data file management scenarios such as creating Outlook mail backup, importing 

emails, reducing data file size, consolidating mails from multiple sources, etc. We wrap this Guide 

with a section focused on Outlook data file corruption and methods to fix the corruption issues. 

The information presented in this guide applies to Outlook 2019, 2016, 2013, 2010, and 2007 on 

Windows operating system.
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WHAT IS AN OUTLOOK DATA FILE?
An Outlook data file is a file for storing a local copy of Outlook emails, attachments, contacts, 

calendar, notes, tasks, folders, etc., on the user’s computer. It is created automatically after 

adding an email account to Outlook. You add an email account to Outlook by navigating to File > 

Add Account and then entering the email address. Further, on-screen instructions help you 

follow the steps to configure the email account, resulting in Outlook data file creation.

TYPES OF OUTLOOK DATA FILE
There are two types of Outlook data files, namely –

PERSONAL STORAGE TABLE (PST) FILE

PST or .pst file format is an open proprietary file format for storing a local copy of mail items such 

as emails, calendar, etc. The PST file is associated with email databases of Microsoft email tools 

such as Outlook, Exchange Server, and Windows Messaging.
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Image 1: Outlook Account Information screen with Add Account button



The Personal Storage Table file format is particularly associated with Outlook email accounts 

configured using Post Office Protocol (POP), also known as POP3. POP is a method wherein the 

email service downloads the new messages from the mail server to the user’s computer. Further, 

it stores the Sent messages on the local computer and not on the mail server.

Notably, Outlook 2013 and earlier versions of Outlook configured with IMAP also use a PST file. 

We mention this among the “existence scenarios” covered later in this Guide.

Advantages of PST file

a)  High portability: PST is a highly portable file format for storing and transferring data between 

different computers, email clients, and mail services, etc. The email data stored in a PST file is 

readily importable in Office 365, Exchange Server, Microsoft 365, etc. 

b)  Email backup utility: PST files provide a convenient and reliable way to create local backups 

of Outlook message folders, including emails, contacts, and calendar, in a restorable form. In 

tandem with automatic email archival facility in Outlook configured with Exchange Server (using 

IMAP or MAPI), PST files provide the local backup utility.

Disadvantages of PST file

a)  Performance and corruption issues: PST files can become slow and corrupt due to abrupt 

termination of Outlook client, large-sized PST file (> 20 GB), PST file stored and accessed on a 

network, Outlook add-ins, etc. As per Microsoft KB 297019, “the use of a .pst file over a network 

connection may result in a corrupted .pst file if the connection degrades or fails.” These issues 

impact Outlook performance and might result in mailbox data loss due to PST file corruption.

b)  Restricted access: PST files store, archive, or back up the mailbox data on a local drive, which 

is inaccessible through any other device or app on a network. Unless Outlook is configured with 

Exchange Server through IMAP or MAPI, wherein an archived backup copy is available on the 

server, there is no way to access the user’s mailbox data apart from the PST file stored on the 

local computer. Of course, the PST file being portable can be copied and moved to another 

system, but nonetheless it remains in local control and can also hamper access if is password 

protected. 
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Advantages of OST file

Offline email access: OST file is a synchronized local copy of the user’s mailbox data on server. 

The file allows offline access to emails, attachments, contacts, tasks, calendar, etc. without need-

ing access to the mail server. The user can perform actions like draft new emails, read past 

emails, add or update contacts, create meetings, etc. with help of the OST file.

Disadvantages of OST file

Mailbox inaccessibility: The OST file needs the associated Exchange Server account to allow 

access to the mailbox data via Outlook. Unlike the PST, you cannot open and export an OST file 

data directly using Outlook client if the user account is deleted from Exchange Server. This situa-

tion poses a technical challenge if you need to extract the mailbox data from inaccessible OST 

files, for example, when the mailbox is purged from Exchange Server and there is no backup.
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c)  Data retention policy concerns: Mailbox data stored in PST files can pose challenges to the 

organization’s data retention policy. For example, it is not possible to manage the PST file data 

using retention tags. Further, keeping track of the mailbox data “actually” backed up on PST files 

is challenging in the absence of a well-defined process and documentation. 

This limitation can result in e-discovery challenges as Exchange eDiscovery tools do not discover 

the data stored in a PST. Even after performing an expensive e-discovery on PST files, there is no 

way to guarantee data integrity to support the litigation needs.

OFFLINE STORAGE TABLE (OST) FILE

OST or .ost file format is a type of Outlook data file that stores a synchronized copy of the user’s 

mailbox data on the local computer. The OST file allows users to access their mailbox data, com-

pose messages, add contacts, create meetings, etc., even when the mail server connectivity is 

disrupted. It automatically synchronizes these offline changes once the Internet connection is 

restored. 

OST file is created for Outlook accounts configured with Microsoft 365, Exchange Server, or Out-

look.com using Internet Message Access Protocol (IMAP) or Messaging Application Programming 

Interface (MAPI).



Purpose

Email protocol

Portability

Security

Accessibility

Manageability

Used for creating local backup, 
transferring mailbox data, consolidating 
emails from supported services, etc.

Provides offline access to emails and 
other mailbox data.

Enabled using encryption or 
password protection.

Requires Exchange-associated account 
to allow mailbox data access.

Automatically synchronizes the data 
with mail server.

Low portability. The file strictly 
associates with the Exchange account 
& client machine. Moving an OST file to 
another disk or folder location requires 
a specific procedure.

IMAP POP

High portability. Can be directly copied 
and moved to another folder or disk.

Enabled using encryption or password 
protection.

Allows direct mailbox data access 
through Outlook client.

PST file is managed offline by an 
individual user or administrator.

Parameter                                   OST File                                                           PST File
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COMPARISON OF OST FILE AND PST FILE

The following table summarizes a comparison of OST file and PST file based on specific parameters:

EXISTENCE SCENARIOS FOR OST & PST FILES
Your system (local computer) may contain a PST file, an OST file, or both file types based on how 

your email account is configured. The following scenarios help you determine the type of Out-

look data files existing on your system:
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SCENARIO 1: MICROSOFT EMAIL CLIENTS CONFIGURED USING POP3 � PST FILE

Microsoft Outlook, Exchange Server, or Windows Messaging mail clients configured using POP 

create a PST file, storing the user’s mailbox data on the local system. In POP mail accounts, the 

incoming messages are downloaded from the server and stored in the PST file.

SCENARIO 2: EMAIL ACCOUNT CONFIGURED USING IMAP � OST FILE

Microsoft mail accounts, including Outlook.com, Exchange Server, and Microsoft 365 email 

accounts, configured using IMAP, store a synchronized copy of the user’s mailbox data as an OST 

file on the local computer.

SCENARIO 3: OUTLOOK MAPI CLIENT WITH EXCHANGE SERVER � OST FILE

Outlook MAPI client (Outlook 2013 and Outlook 2016) configured with Exchange Server mail 

account results in OST file creation. For this, you need to enable Cached Exchange Mode in Outlook 

if it is not turned ON by default.

SCENARIO 4: OUTLOOK 2013 OR EARLIER VERSION WITH IMAP � PST FILE

In Outlook 2013 or older versions, email accounts configured with IMAP used .pst files to store 

the mailbox data. It means, Outlook 2013 and older accounts, irrespective of POP or IMAP 

configuration, store the users’ mailbox data in a PST file.

SCENARIO 5: CREATING LOCAL BACKUP IN SCENARIO 2 OR 3 � PST & OST FILE

Suppose you create a local backup of Outlook MAPI client configured with Exchange Server or 

another Microsoft mail service (like Outlook.com or Microsoft 365) configured with IMAP. In that 

case, both OST and PST files will exist on the local system. The PST file is created when you 

exported the Outlook mailbox data to create a local backup.

OUTLOOK DATA FILE LOCATION
Outlook saves the data files at specific locations based on the Outlook version installed on the 

system. Also, the type of Outlook data file, i.e., OST or PST, on the computer depends upon the 

mail account configuration outlined in the previous section. The following are the default locations 

of Outlook data files:

Outlook 2007 and 2010

C:\db1>eseutil /mh db1.edb
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HOW TO LOCATE OUTLOOK DATA FILES?

Aside from manually navigating to an Outlook data file location, you can directly locate and open 

the data file location using the following steps:

1.  Launch Outlook and click the File tab 

2.  Click Account Settings

Outlook 2013, 2016, and 2019

C:\users\<username>\Documents\Outlook Files

Image 2: Outlook Account Setting screen
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3.  Click the Data Files tab, click a data file, and then click Open File Location.

Image 3: Screen to select an Outlook data file and open its location
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WORKING WITH OUTLOOK DATA FILES
This section explores the scenarios where you need to work with Outlook data files to accomplish 

tasks such as taking a local backup of emails, importing messages from PST �le, reducing the PST �le size, 

splitting PST �les, consolidating data from multiple PST �les, etc.

SCENARIO 1: NEED TO CREATE A LOCAL BACKUP OF OUTLOOK EMAILS

Using Exchange (i.e., Outlook MAPI) or IMAP account automatically archives the emails and other 

mailbox data on the server. However, Outlook also allows exporting the message folder to a .pst �le using the 

Import/Export feature. You can export message folders, contacts, calendar, tasks, etc. and create a local 

backup in the PST �le as follows:

1.  Launch Outlook and click File > Open & Export > Import/Export

Image 4: Outlook Import/Export feature
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2.  Select the ‘Export to a file’ option and click Next.

3.  Select the ‘Outlook Data File (.pst)’ option and click Next.

Image 5: Email import/export options in Outlook

Image 6: File format options to export Outlook messages
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4.  Select the folders you need to back up and click Next. You can also use Filter to specify the 

     emails by sender, recipient, specific text match, etc., and back up those messages.

Image 7: Screen to select Outlook folders for backup

5.  Browse the location to save the PST file and click Finish.

Image 8: Screen to browse the PST file location for backup
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1.  Navigate to Outlook Import/Export screen as described in Step 1 of the local backup scenario 

     [See Image 4]

2.  Select the ‘Import from another program or file’ option and click Next.

6.  At this stage, you get an option to add a password to the PST file to restrict access. You can add 

     the password or leave the field blank. Click OK to start exporting the selected Outlook messages 

     and other mail items in a PST file. 

SCENARIO 2: NEED TO IMPORT EMAILS FROM AN OUTLOOK PST

This scenario comes up frequently when you are moving Outlook items between different 

computers or email accounts. For example, you may be changing your personal computer and 

need to migrate your locally stored email data to the new system. Or, you may need to import 

your Gmail data in Outlook, which was previously exported to a PST file.

The Outlook data file import method described here assumes that you already exported the 

messages and other mail items described in Scenario 1. You can import emails, contacts, and 

calendar from the PST file as follows:

Image 9: File import options in Outlook.
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3.  Select the ‘Outlook Data File (.pst)’ option and click Next. [See Image 6]

4.  Browse the PST file you need to import. You can select a suitable option to manage the import 

     of duplicate items and then click Next.

Image 10: Screen to browse the PST file for importing
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5.  Choose the ‘Import items into the current folder’ option to save the items in the current folder. 

     Alternatively, you can select the ‘Import items into the same folder in:’ option to import the mail 

     items in your Microsoft 365 mailbox.

6.  Click Finish to start importing the emails, contacts, and calendar from the PST file.

Image 11: Options to import Outlook items in the current folder or Microsoft 365
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SCENARIO 3: NEED TO REDUCE THE OUTLOOK DATA FILE SIZE

This scenario involves actions such as compacting and cleaning up the Outlook data file (PST or 

OST) to reduce its size. Following are the methods to reduce Outlook data file size:

Method 1: Use Outlook Mailbox Cleanup tool

The Mailbox Cleanup tool is a utility to manage the mailbox size. It allows you to find mail items 

by size and timeline, empty the deleted items folder, or archive specific items. Following are the 

steps to use the tool:

1.  Launch Outlook. Click File and then click Cleanup Tools

Image 12: Outlook Mailbox Cleanup Tool



Method 2: Use Outlook Conversation Clean Up feature

Outlook Conversation Clean Up feature moves the unwanted messages to the Deleted Items 
folder. It evaluates an email conversation, i.e., the emails from the starting message to all 
responses having the same subject line, and deletes the redundant messages accordingly. This is 
how you use the Conversation Clean Up feature:

1.  Launch Outlook and click Clean Up option in the Home tab.
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2.  Click the Mailbox Cleanup option. The utility screen will open with options to view mailbox size, 

     find mail items, view deleted items size, etc. You can identify specific mail items using the Find 

     option and perform mailbox cleanup through deletion, archiving, etc.

Image 13: Outlook Mailbox Cleanup Tool Interface

Image 14: Outlook Clean Up Conversation options



Method 3: Compact the Outlook data file

Compaction is the process of optimizing the usage of white space or unused space in the Outlook 

data file (PST or OST). You can compact the data files using Outlook built-in utility  or third-party 

software as follows:

a)  Use Outlook built-in compaction function 

Following are the steps:

1.  Launch Outlook. Click File > Account Settings to navigate to the Account Settings window. 

     [See Image 2]

2.  Click Data Files tab, select the data file, and then click Settings.
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2.  Choose one of these options:

     •  Clean Up Conversation – cleans redundant messages in a specific email conversation.

     •  Clean Up Folder ¬– evaluates and deletes unwanted messages from a folder

     •  Clean Up Folder & Subfolders – checks the selected folder & underlying subfolders & deletes 

         the redundant messages.

Image 15: Screen to access Outlook data file settings
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3.  Click the Advanced tab and then click Outlook Data File Settings.

4.  Click Compact Now. Outlook will start compacting the selected PST or OST file.

Image 16: Screen to access Outlook data file advanced settings

Image 17: Screen to access the compaction feature in Outlook
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b)  Use third-party software for compacting PST files

Aside from using the Outlook built-in feature, you can try a software utility like Stellar Compactor 

for Outlook for compressing the PST file size. The utility is a part of Stellar Toolkit for Outlook, a 

software package comprising different tools for managing Outlook data files.

Following are the steps for using the software:

1.  Launch Stellar Toolkit for Outlook and click Compact Outlook PST. [See Image 18]

2.  On Stellar Compactor for Outlook Home tab, click Add PST or Drag & Drop.

Image 18: Stellar Toolkit for Outlook Launcher 
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Image 19: Stellar Compactor for Outlook Home screen

Image 20: Open a PST file in Stellar Compactor for Outlook

3.  Browse and select the PST file. Click Open.
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4.  Specify the Destination to save the compacted PST file. Select one of the options to compact the file:

     •  Compress all the attachments

     •  Extract the attachments in a folder with interlinking

     •  Extract and compress the attachments with interlinking

     •  Remove the attachments

Click Compact to start compacting the PST file.

Image 21: Options to compact the PST file 

SCENARIO 4: NEED TO SPLIT A LARGE PST FILE

Sometimes you may prefer splitting a PST file instead of compacting or cleaning it. For example, 

you may want to maintain (i.e., save, archive, backup) the mailbox data of a user in a single PST 

file. This PST will continue growing in size as more data gets stored in it. Splitting such a 

large-sized PST file (nearing the 50 GB size limit) can improve its manageability without deleting 

the messages, emptying the deleted items folder, or optimizing the white spaces.
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There is no native feature or utility available in Outlook to split PST files. However, you can still split 

a PST file using third-party software such as Stellar Splitter for Outlook. The tool can split PST files 

based on date, size, email ID, and folders.

Steps to split PST files

1.  Launch Stellar Splitter for Outlook. 

2.  On the Home tab, click Add PST or Drag & Drop.

Image 22: Stellar Splitter for Outlook Home screen

3.  Browse and select the PST file. Click Open.
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4.  Specify the Destination to save the split PST files. Choose the Splitting Option to split the PST 

by date, size, email ID, and specify the range for splitting. For example, date range, PST file size, 

etc. Click Split.

The software will split the PST based on the specified criteria and save the files at the destination 

location.

Image 23: Open a PST file in Stellar Splitter for Outlook 
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Image 24: Options to split the PST file

SCENARIO 5: NEED TO CONSOLIDATE MAILS FROM MULTIPLE ACCOUNTS

There are situations when you may want to consolidate (or merge) the emails, contacts, calendar, 

etc., from multiple email accounts in a single email data file. You can consolidate emails by 

extracting the mailbox data associated with multiple accounts in separate PST files and then 

combine those in a single PST file. 

For example, you can extract Gmail data such as messages, attachments, contacts, etc., in a PST 

file by configuring Gmail with Outlook and then exporting the data in .pst file format. Likewise, 

you can export the Outlook account data in a PST file and then import both PST files in the same 

folder to consolidate the mail items in a single Outlook data file. The following steps provide 

instructions to consolidate the mailbox data from multiple accounts in a single PST file.

a)  Use Outlook for combining or merging mails in a PST file
In this method, we consolidate Gmail mailbox items with existing emails in an Outlook account.
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Step 1: Configure Gmail with Outlook

1.  Launch Outlook and Click File > Add Account.

2.  Enter user name, Gmail ID & password, and click Next. Gmail account will be configured with 

     Outlook client and Gmail mailbox data will start syncing with Outlook. You will be able to view 

     and access Gmail items through Outlook.

Image 25: Add new account in Outlook

Image 26: Add Gmail account to Outlook
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Step 1: Configure Gmail with Outlook

1.  Launch Stellar Merge Mailbox for Outlook. 

2.  On the Home tab, click Add PST or Drag & Drop.

Step 2: Export Gmail data to PST

Follow the instructions outlined in Scenario 1 for backing up Outlook mailbox data by exporting it 

in PST file. In bullet point 4 of the instructions in Scenario 1, select the entire Gmail profile data and 

export the mailbox data to a PST file.

Step 3: Import the Gmail data from the PST 

Follow the instructions outlined in Scenario 2 and import the PST file containing Gmail mailbox data. 

Choose the ‘Import items into the current folder’ option to save the items in the current folder. After 

importing the PST file, you will see the complete data combined (i.e., merged) within the default 

Outlook profile.

b)  Use third-party software to merge or join PST files

You can merge or join multiple PST files using a software utility such as Stellar Merge Mailbox for 

Outlook. The software can “merge” PST files, including emails, contacts, notes, calendars, tasks, etc., 

in a single PST. It can also join PST files, adding each PST as a separate folder structure in the output 

file. Following are the steps to merge or join PST files using the software:

Image 27: Stellar Merge Mailbox for Outlook – Home screen
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4.  Choose the option to merge or join the PST files. You can merge or join the files to a new or existing 

     PST file, Office 365, Exchange Server, or Outlook profile. 

5.  Select the items listed in the left pane for inclusion in the merged or joined PST file. 

6.  Next, browse and select the destination for saving the merged mailbox data and click Merge. 

3.  Browse and select the PST files. Click Open and then click Next.

Image 28: Open PST files in Stellar Merge Mailbox for Outlook
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Image 29: Options to merge PST files 

The tool will start processing the PST files and save the output PST to the specified location.

SCENARIO 6: NEED TO EXTRACT DATA FROM INACCESSIBLE OST FILE 

As understood earlier, the OST file stores a synchronized copy of the mailbox data on Exchange 

Server to allow offline access. OST files are only accessible through the users’ associated 

accounts on Exchange Server. If the user account is deleted from Exchange Server, the OST file 

turns inaccessible. If a mailbox is purged from Exchange and there is no backup, the only way to 

get back the data is through the inaccessible OST file. 

In this scenario, you need to find a way to extract the mailbox data from the OST file. You can use 

Stellar Converter for OST to convert inaccessible OST files and extract the mailbox data in PST 

files. Please read this software KB for detailed instructions on how to extract OST file data using 

the software.
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OUTLOOK DATA FILE CORRUPTION: ERRORS & TROUBLESHOOTING
A PST file can affect Outlook’s normal functioning and result in Outlook crash, freezing, inability 

to start, slow down, etc. These issues primarily emerge from underlying corruption, i.e., data 

structure integrity problems, in the PST file (or OST file) triggering the following error messages:

0x80040116

0x80040119

0x80040600

0x80070002

Not available

Not available

Not available

Outlook.pst cannot be accessed

An unknown error has occurred 

An unknown error has occurred 

An unknown error has occurred 

Errors have been detected in the file 
C:\Users<name>\AppData\Local\Microsoft\Outlook\user@org.com.ost

Cannot start Microsoft Outlook

Cyclic redundancy check error

Error Code                    Error Message

Please see this comprehensive list of Outlook errors. A majority of these error messages indicate 

PST file corruption and can result in the loss of critical emails and other mailbox data. So, it is 

imperative to be aware of the methods to fix PST file corruption we cover in the following section.

METHODS TO REPAIR PST FILE CORRUPTION

There are essentially two methods to troubleshoot and resolve corruption issues in the PST file 

(or OST file), as applicable based on your Outlook version and email account configuration. These 

methods are based on using the Inbox Repair tool (Scanpst.exe), an in-built utility available with 

Outlook, or Stellar Repair for Outlook — a third-party PST & OST file repair software.
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Method 1: Use the Inbox Repair tool to fix PST or OST file corruption

Before running the Inbox Repair tool or Scanpst.exe, you would need to locate it on the computer 

system. Following are the Scanpst.exe file locations based on the Outlook version installed on 

your system.

Once you know the Inbox Repair tool (Scanpst.exe file) location, follow these steps:

1.  Press Ctrl + R and enter the path to navigate to the Scanpst.exe file location.

Outlook 2016

Outlook 2019

Outlook 2013

Outlook 2010

Outlook 2007

C:\Program Files (x86)\Microsoft Office\Office19\
C:\Program Files\Microsoft Office\Office19\
C:\Program Files (x86)\Microsoft Office\Office16\
C:\Program Files\Microsoft Office\Office16\

C:\Program Files (x86)\Microsoft Office\Office15\
C:\Program Files\Microsoft Office\Office15\
C:\Program Files\Microsoft Office\root\office15\

C:\Program Files\Microsoft Office\Office14\
C:\Program Files (x86)\Microsoft Office\Office14\
C:\Program Files\Microsoft Office\Office14\

32-bit Windows: C:\Program Files\Microsoft Office\Office12\
64-bit Windows: C:\Program Files (x86)\Microsoft Office\Office12\

Outlook version            Scanpst.exe file location
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Image 30: Location of Scanpst.exe file

Image 31: Scanpst.exe tool screen to browse the PST file

2.  Double click SCANPST and browse the Outlook data file you need to scan. Close Outlook and 

     all mail-enabled applications. Next, click Start to start scanning the selected PST or OST file.

The tool interface shows the scan results. It creates a backup of the PST file before repairing.
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Image 32: Scanpst.exe – repair the PST file

How does Inbox Repair tool work?

Scanpst.exe or Inbox Repair tool rectifies the errors at the data structure level. It diagnoses the 

Outlook data file, including the folders, messages, etc., and checks the tables & blocks for anomalies 

or integrity problems.

2.  Click Repair to start repairing the Outlook data file. 

4.  After the repair process is complete, create a new PST file in your Outlook profile by navigating 

     to New Items > More Items > Outlook Data File.

5.  Import the mailbox items from the repaired PST file in the newly created PST file. Refer to 

     Scenario 2 for instructions.

Caution: ⚠ 

Scanpst.exe removes any information block it finds unreadable or corrupt. Microsoft documentation for 
the Inbox Repair tool notes that the utility may require multiple passes to repair the PST file. Also, the tool 
cannot repair every problem and does not recover permanently deleted or corrupted items.



EXCHANGE DATABASE CORRUPTION — TROUBLESHOOTING GUIDE 16EXCHANGE DATABASE CORRUPTION — TROUBLESHOOTING GUIDE 33FUNDAMENTALS OF OUTLOOK DATA FILES — GUIDE

Method 2: Use PST file repair software to fix corruption issues

Another method to repair corrupted PST and OST files is based on Stellar Repair for Outlook, a 

software designed to address severe corruption levels and recover all mailbox items, including 

deleted emails.

Please refer to the user manual for the steps.

Image 33: Stellar Repair for Outlook – Home screen
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CLOSING NOTES
In this Guide, we shared Outlook data files’ fundamentals, their purpose, existence scenarios, 

and comparison. We outlined the real-world scenarios entailing OST and PST file management 

and explained how to fix PST file corruption using the Inbox Repair tool and third-party PST file 

repair software. Most of the knowledge focused on hands-on methods to provide a practical 

perspective of Outlook data file management. 

REFERENCES
Create email backup

Import emails in Outlook

Outlook Conversation Clean Up feature

How to use Inbox Repair tool 
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